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Conventions

This guide uses the icons shown below to indicate important information. Always observe the

instructions indicated by these icons.

A Warnin Instructions that if ignored could result in serious personal injury or even death as a result of
9 careless operation of the equipment. Observe these warnings for your safety.

Instructions that if ignored could result in minor injuries or material damage as a result of
Caution ) ) ) !
careless operation of the equipment. Observe these cautions for your safety and to avoid

damaging the equipment.

@

Reference

Instructions or advice to help you use the printer more efficiently or to avoid minor problems.

References to other pages or documents supplied with your printer.

Instructions specifically for Windows 95 and Windows 98 users. Some of the dialogs you see on your screen may be
slightly different, depending on which operating system you are using. However, the basic procedures apply to your
system. For details about using the Windows NT 4.0 Printer driver, click the Start button, point to Programs and

BJC-8200, and click Guide.

Machintosh

Instructions specifically for Macintosh users.

Trademarks

Canon, BJ and BJC are trademarks of Canon Inc.
Microsoft®, Windows® and Windows NT® are
registered trademarks or trademarks of Microsoft
Corporation of the U.S. and in other countries.

Macintosh and Power Macintosh are registered
trademarks or trademarks of Apple Computer Inc. of the
U.S. and in other countries.

All other company or product names used in this guide
are trademarks or registered trademarks of their
respective companies.

About this document

In this document Microsoft® Windows® 95, Microsoft®
Windows® 98 and Microsoft® Windows NT® 4.0 are
referred to as Windows 95, Windows 98 and Windows
NT 4.0.

Unauthorised transfer or duplication of all or any part of
this User’s Guide is prohibited.

The content of this User’'s Guide is subject to change
without notice.

Every effort has been made to ensure that the
information contained in this guide is correct. If any error
or omission is found, contact the nearest Canon office
by referring to the Contact List provided with the printer.

Canon is not responsible for any damages, direct or
indirect, arising from or related to the use of this printer.

Copyright ©1999 CANON INC. ALL RIGHTS RESERVED.

/International ENERGY STAR®

Program

As an ENERGY STAR
Partner, Canon Inc. has
determined that this product
meets the ENERGY STAR
guidelines for energy
efficiency.

The international ENERGY STAR Office Equipment
Program is a global program that promotes energy
saving through the use of computers and other office
equipment. The program backs the development and
dissemination of products with functions that effectively
reduce energy consumption. It is an open system in
which businesses can participate voluntarily. The
targeted products are office equipment such as
computers, monitors, printers, facsimiles, and copiers.
Their standards and logos are uniform among

warticipating nations. /




AUsing the Printer Safely

Read and follow all of these cautions and warnings to ensure the safe use of the printer. To avoid
the hazards of fire, personal injury, or damage to the printer, never attempt to use the printer in any

way other than the methods described in this guide.

Choosing a location

Never place the printer near flammable
solvents such as alcohal, thinner, etc.

To avoid the hazards of fire or
electric shock, keep all flammable
liquids away from the printer.

Power supply

Never attempt to plug the power cord into a
power outlet when your hands are wet.

To avoid electric shock, make sure
that your hands are dry.

Always push the plug completely into the
power outlet.
A loose or poorly connected plug

could cause a fire or electric
shock.

Never cut, modify, stretch, bend, or twist the
power cord, and never place heavy objects on
the power cord.

A power leak from a damaged

power cord could cause a fire or
electric shock.

Never plug the printer power cord into a power
outlet (power board, double adapter, etc.) that
is shared by other devices or office
equipment.

To prevent the hazards of fire or

electric shock, avoid overloading
power points.

Never use the printer if the power cord is
bundled or knotted.
To prevent the hazards of fire or

electric shock, make sure the
power cord is straight.

If you detect smoke, unusual odours, or
strange noises around the printer, immediately
press the POWER button to switch the printer
off and disconnect the power plug.

To avoid fire or electric shock,
never use the printer under these
conditions. Call for service.




Cleaning the printer

Use only a slightly damp cloth to clean the
printer. Never use flammable solvents like
alcohol, benzene, thinner, etc.

If a flammable solvent contacts an
“s.| electrical component inside the

3| printer, this could cause a fire or
electric shock.

Always unplug the printer power cord before
you clean the printer.

If you mistakenly switch the printer
on while cleaning it, you could

|
‘(% touch moving components inside
ﬁ @ the printer and suffer injury.

Maintaining the printer

Never attempt to disassemble or modify the
printer.

The printer contains high voltage
components which could cause a
fire or serious electric shock.

Working around the printer
Never use flammable sprays near the printer.

Gases in the spray could cause a
fire or electric shock if they come
in contact with electrical
components inside the printer.

About your guides

Choosing a location

Never set the printer on a surface that is
unstable or subject to excessive vibration.

The printer could tip or fall and
cause injury.

Never use the printer in a location that is
subject to high humidity, dust, high
temperatures, or direct sunlight.

7| Set up and use the printer in a
~ location where ambient

(41°F~95°F) and 10%~90%
humidity with no condensation.

Never place the printer on a thick carpet or
rug.

Fibres or dust entering the printer
could cause a fire.

Keep the power outlet for the printer free of all
obstacles so you can unplug the power cord
at any time.

Such obstacles could prevent you
from unplugging the printer when
a printer fault occurs and cause a
fire or electric shock.



Always carry the printer with both hands
gripping both ends of the printer.

To avoid dropping the printer and
causing injury, always carry it
carefully when moving it to another
location.

Power supply

Always grasp the plug when you unplug the
power cord.

Pulling on the power cord could
damage the cord and cause a fire
or electric shock.

Never use an extension cord.

To avoid a fire or electric shock,
always plug the power cord
directly into the power outlet.

Never use a power supply voltage other than
that supplied in the country where you
purchased the printer.

Using incorrect voltage could
cause a fire or electric shock.

The correct power supply voltages
for this printer are determined by
the country of purchase:

USA/Canada AC 120V, 60 Hz
Australia AC 240V, 50 Hz
Europe AC 230V+10%, 50 Hz

Working around the printer

Never insert your fingers or hands inside the
printer while it is printing.

The printer contains moving parts
which could cause injury.

Never place anything on top of the printer,
especially metal objects (paper clips, staples,
etc.), or containers with flammable solvents
(alcohoal, thinners, etc.)

Objects falling into the printer
could cause a fire or electric
shock.

If any foreign object, especially a piece of
metal or liquid, falls into the printer,
immediately press the POWER button to
switch the printer off, unplug the power cord
and call for service.

Continuing to use the printer after
a foreign object has fallen into it
could cause a fire or electric
shock.




BJ Print Head and ink tanks

For safety always store BJ Print Head and ink
tanks out of the reach of small children.

If a child accidentally licks or
ingests any ink, consult a
physician immediately.

Never subject a BJ Print Head or ink tank to
shocks or excessive vibration.

Shaking could cause ink to leak
and stain clothing.

Never touch the print head or electrical
contacts on a BJ Print Head immediately after
removing it from the printer.

These metal parts become very
hot during printing and could
cause minor burns.

Switching the printer off

To avoid printer malfunction always use the
POWER button to switch the printer on and
off.

Never remove the power cord from
the power outlet until you have
switched the printer off by pressing
the POWER button. After the
POWER/ERROR lamp
extinguishes, you can unplug the
power cord from the power outlet.

Using the Printer Safety

Using the printer near appliances
and fluorescent lamps

Allow at least 15 cm clearance between the
printer and another appliance or a fluorescent
lamp. Electrical noise generated by a
fluorescent lamp placed too close to the
printer could cause the printer to malfunction.

fReguIations for the United h

Kingdom

This equipment is approved under approval
number NS/G/12345/3/100003 for indirect
connection to public telecommunication
systems in the United Kingdom, i.e. when
connected to the correct interface of a type
approved apparatus in accordance with the
instructions for use of that apparatus. If you
are uncertain about the connection
arrangement, seek the help of a qualified
engineer.

Ubereinstimmungserklarung
entsprechend EN55 022

Dieses Produkt ist zum Gebrauch In
Wohnbereich, Geschafts- und
Gewerbebereich sowie in Kleinbetrieben
vorgesehen.

Canadian Radio Interference
Regulations

This digital apparatus does not exceed the
Class B limits for radio noise emissions from a
digital apparatus as set out in the interference-
causing equipment standard entitled “Digital
Apparatus”, ICES-003 of the Industry of
Science Canada.

Cet appareil numérique respecte les limites de
bruits radioléctiques applicables aux appareils
numeériques de Classe B prescrites dans la
norme sur le matriel brouilleur: “Appareils
Numeériques”, NMB-003 édicatée par

\I’Industrie et Sciences Canada.
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About your guides

With the BJC-8200 you are provided with three guides, in addition to the on-line Help in the printer
driver. Read the “Quick Start Guide” to set up the printer, read the “User’s Guide” for instructions on
how to use the printer, then refer to the “Reference Guide” or on-line Help when you have a
guestion.

Here is a brief summary of all the reference material provided with the printer.

Quick Start Guide

Follow the instructions in this guide to perform all the procedures for
setting up the printer, including installing and aligning the print head,
connecting the printer and computer, installing the printer driver and
scanner drivers.

the printer. Store this guide in a safe place so you can find it for

@ e You will need the “Quick Start Guide” if you move or transport
future reference.

User’s Guide (on CD-ROM)

After setting up the printer, read the “User’'s Guide” to become familiar
with the basic operations:

« Printing a photograph

« Using the optional Scanner Cartridge

« Using the printer driver

« Using plain paper and selecting the correct media for special print

jobs
 Troubleshooting minor problems

After you read the “User’s Guide”, you will know how to print a !
photograph and know most of the procedures for the daily operation

of the printer. Read this User’s Guide as soon as you have completed

setting up the printer.



Reference Guides (on CD-ROM)

Refer to the Reference Guides on the CD-ROM for full descriptions of
the printer features and how to use the printer. Two guides are
provided on the CD-ROM: the BJC-8200 Reference Guide for the
printer and the 1S-52 Reference Guide for the Scanner Cartridge. You
can open the guides on the screen for more details about printing
techniques and printer operation. The Reference Guides contain the
following basic information:

 Printing and scanning techniques

« Basic software operating procedures

« Practical applications for printing and scanning features

« Using special print media

 Detailed troubleshooting procedures
Use the “Reference Guide” during printer operation when you have a
question about a printing or scanning procedure or if you encounter a
problem.

e The “Reference Guides” are provided on the CD-ROM.
For Windows: Insert the CD-ROM in the CD-ROM drive. On
the first screen, click the Reference Guide button.
For Mac: Insert the CD-ROM in the CD-ROM drive. Open the
Manual folder, then select the desired language.

¢ |n order to open “Reference Guide”, you must have Adobe
Acrobat Reader installed on your computer.
For details, refer to the instruction booklet provided with the
CD-ROM.

On-line Help

The printer driver and scanner driver are both provided with extensive
on-line Help which you can view while using either driver. Refer to
Help for more information about driver features, procedures, notes,
and precautions. Opening Help provides easy access to information
when you have a question during operation of the printer.

To open the on-line Help, use one of the following methods:

¢ Right-click an option and then click the Help button.

¢ Click the icon in the upper right corner of the dialog box and
then click an option.

« Click the Help button at the lower right of the dialog box and
select a keyword you want to know from the List, or enter the
keyword in the Search box.

About your guides
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Printing

Make sure that you have read the Quick Start Guide and completed all the steps to set up the
printer and prepare it for operation. This chapter describes how to print a photograph and how to
use the optional Scanner Cartridge.

Is everything ready?

Before you begin, make sure that you have everything that you need.

Have you completed setting up the printer?

Make sure that the printer has been set up completely and that the print head has been
aligned. If you have not performed all of these procedures, you must follow the instructions in
the Quick Start Guide to set up printer and align the print head.

BJ Print Head and ink tanks installed?

Printer cable connected to the printer and computer?
Is the printer driver installed?

Has the print head been aligned?

Is the printer ready to print?

Is the printer switched on?
When the printer is switched on, the POWER/ERROR lamp flashes green for a
few seconds then lights steadily green. When the POWER/ERROR lamp lights
and remains on, the printer is ready to print. If the POWER/ERROR lamp flashes
or lights orange, an error has occurred. For details, see Chapter 4.

Is the printer cable securely connected to the printer and computer?
If the printer cable is not connected to the printer and computer correctly, an
error can occur or meaningless characters could print.

D

The buttons and lamp for manuglly operating the @ off Printer is switched off.
printer are located on the operation panel.
Lights Green Printer is ready.
999 :
i Flashes Green Printer is warming up after power on, or is
] @ ® @ receiving a print job from the computer.
Lights Orange Printing has stopped because an error has
1 POWER button @ occurred.
Press to switch the printer on and off. @ Flashes Orange | Call for service.
2 POWER/ERROR lamp

When you switch on the printer, the POWER/ERROR 3 RESUME button

lamp lights, green. If this lamp lights or flashes Press the RESUME button to cancel errors after

orange, an error has occurred. removing the problem so the printer can resume
normal operation.



Printing photographs

Printing photographs

The BJC-8200 is designed to reproduce the highest quality reproduction of color in photographic
images, and in order to achieve this, some special settings are required in the printer driver. When
the printer driver is opened, it is usually set for printing on plain paper documents created with a
word processor or similar program. For special print jobs like printing a photograph on photo paper
or some other special media, special printer driver settings are required.

o))
=
=
=
=
o

Canon provides a variety of special media, Photo Paper Pro PR-101, Glossy Photo Paper GP-301,
High Resolution Paper HR-101, and others, for special print jobs where superior reproduction of
color is required.

Printing a color
photograph

What is Photo Paper Pro?

Canon Photo Paper Pro PR-101 is recommended when you need to achieve the best quality in printing photographs. Slightly
thicker than High Resolution Paper HR-101, the print side of Photo Paper Pro, is the side with the glossy surface. For details
about Photo Paper Pro and other special print media, see Chapter 3.

Summary of printing photographs

1 What is the printer driver?

Set the media in the printer. The text and image data that you
- 7 I create with a software
el fiieg g | application cannot be printed
I until the printer driver has

. . L converted it into a format that the
Print the photographic image from the 3 printer can understand. For

software application. details about using the printer
driver, see Chapter 2.

e |f you have the optional Color Image Scanner Cartridge 1S-52, you can scan a photograph that you want to
print. Referring to “Using the Scanner Cartridge” in this chapter, try to scan your original photograph and
then print it.

WLl ———» P.12

\VEW(I i ————» P.14
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(i Printing a photograph in Windows 98, Windows 95 )

Follow this procedure to print a photograph.

1. Set the media in the printer.

: e The procedure to set the media may differ depending
on the media you are using. For details, refer to the

“Loading Paper and Special Print Media” in Chapter 3.

2 . Make sure that the printer is switched on.
e The POWER lamp should be it green.

3. Make sure that the printer is selected as the default
printer.
e Click the Start button, point to Settings, and click
@ Printers. If the printer is not marked with a check mark,
right-click the Canon BJC-8200 printer icon and select
Set as Default.

4. Start the software application. From the File menu,
select Open, and open the photo image file that you
want to print.

5. From the File menu, select Print.
e The Print dialog opens.

Click!

12



Printing photographs

6. Click the Properties button. 5
e The Printer Properties dialog box opens. e ey _ Click! o
e il =
[ T - =]
=P i =
L L | o
:P-I- . - J.i_-IJ_IJ r
] e |
7. Click the SuperPhoto for the Print Mode and select the - | I i
Media Type for your print job, then click the OK button. = £l e o om o
e If you want to print an image taken by a digital camera, a2 L‘jﬂ-—-— | Click: I
@ click Camera for the Print Mode. i r.__ = S -
e You can not only reproduce photos as they were e [ — - Click!
taken. Before you start the print job, you can select II.-'-q'_- o :: :_
options to enhance image to create artistic effects. B
Simulate illustration e b -
1L T e
T N N |
(Lol ) e
Click!
Sepia print
e For more details about printer driver options, refer to
the BJC- 8200 Reference Guide on the CD-ROM.
s |
8. Click the OK button to start the print job. - ET——— |
e The image begins to print. : :'-!'-“'-l-
P
T — : TEEE
P g B
L Smtndpen [ o
:llI- - _IJ_-IJ e
(==RE_%
|

Click!
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(2 Printing a photograph with the Macintosh

When you want to print image data, follow the instructions below.

1.

Set the media in the printer.

e The procedure to set the media may differ depending
on the media you are using. For details, refer to the

“Loading Paper and Special Print Media” in Chapter 3.

Make sure the printer is switched on. ON ‘

¢ The POWER lamp should be lit green. N /jt
@'®

Eft Famt 35

From the File menu, select Open, and open the photo

image file that you want to print. Clickd
. ‘ Oese =W
e The image file opens. Sanm 43

e At
Paspe Sedup..
Primdt.., P
Primd Qmep Cogry

fuit g

uE- et 5

From the File menu, select Print. P T
Open.. G

(6 ] W

® The Print dialog box opens.

(T i




5. Click the (Photo) icon for the Print Mode.

About your guides

A — - re—

=
e L TR "IELI'I

6. Select the Media Type for your print job.

7. Click the Print button.
e The image begins to print.

L] r—
| i— =
E e E ..
e e Eat g
e —— (==
[l rem i
El e b -
Click!
A — e
Comma [0] P mem ziwem | fu || E
L] P
e Sii— 1]
fr—r— %I !II_!'EI [
S E===
e S
| B~ ]
=1 mn-
Py
s e
Fewes Fagre Py
mehee Click!

4 _E(E
o (B Powes. mi Tibem | | |

= =
S —— =
;- ey B S |_='|

Printing -
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Using the Scanner Cartridge

Your printer can also perform as a scanner. To convert the printer to scanner, install the optional
Color Image Scanner Cartridge 1S-52. With the Scanner Cartridge installed, you can scan and print
photographs. In this section we will show you how to install the Scanner Cartridge, scan a

photograph, and print the scanned image.

T ol mmmh | =>o
—— | mp

Scanning Printing

|

What you need
The following items are required in order to use the printer as a scanner. Make sure that you have
all the items listed below.

Storage container

A photograph of your choice (original) ~ Color Image Scanner Cartridge 1S-52
(provided with the Scanner Cartridge)

o

Media to print White calibration sheet

Scanning holder
(required for printing the scanned image) (provided with the Scanner Cartridge)

(supplied with the Scanner Cartridge)

~—_

—

e |n order to use the Color Image Scanner Cartridge IS-52, you must install the IS Scan scanner driver on your

computer. For details about installing IS Scan, refer to the printer Quick Start Guide. For details about using
the Scanner Cartridge, refer to the 1IS-52 Reference Guide on the CD-ROM provided with the printer.
e The description in this section is written on the assumption that you have already installed the printer driver

and aligned the print head. For details, refer to the Quick Start Guide.
e |f you experience problems during scanning, refer to “Scanner Cartridge does not operate correctly”. (P.76)

16



Using the Scanner Cartridge

Summary of the scanning procedures

Here is a brief summary of the general steps required to convert the printer into a scanner, scan an
original, and print it.

Printing -

Install the Scanner Cartridge in the printer.

U U U U
- G

Perform white level calibration.

Scan the original photograph.

C

Save the scanned image.

C

Install the BJ Print Head and print the scanned image.

IR IR
C

Now let’s scan a photograph and print it !

17



Install the Color Image Scanner Cartridge 1S-52

The Scanner Cartridge is installed after removing the BJ Print Head.

Switch on the printer and open the front cover.
e The BJ Print Head moves to the centre automatically.

Remove the BJ Print Head and insert it into the storage
container.

1 Raise the lock lever and remove the BJ Print Head.

2 Place the BJ Print Head in the storage container.

e To prevent the print head from becoming dirty or drying out,
place the BJ Print Head in a storage container immediately
after you remove it from the printer. The container can be used
to store the BJ Print Head or the Scanner Cartridge.

e To avoid personal injury, never touch the electrical
contacts on the BJ Print Head after removing it from
the printer. The electrical contacts become very hot
during printing.

® To avoid spilling ink on your hands or clothing,
handle the BJ Print Head carefully to avoid

dropping it.

¢ \When you are finished scanning, remove the
Scanner Cartridge from the printer and install the Storage
BJ Print Head in the printer. Do not leave the container

Scanner Cartridge installed in the printer.

Install the Scanner Cartridge in the printer.

1 Install the Scanner Cartridge in the holder where you removed the
BJ Print Head.

2 Lower the lock lever to lock the Scanner Cartridge in place.

e To avoid poor scanning performance caused by
static electricity or foreign matter like dust or dirt,
never touch the scanning head or electrical
contacts.

Close the front cover.

WLV ——— > P.19

— e
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Using the Scanner Cartridge

(2 Perform white level calibration )

The first time that you use the scanner, you must perform white level calibration with the white

)]
calibration sheet provided with the Scanner Cartridge. White calibration defines the base color =
. c
white for the computer. S
1. Start IS Scan Plus.
e Click the Start button, point to Programs, click IS Scan Plus, then
click IS Scan Plus. IS Scan Plus starts.
e |f you want to use IS Scan from within a TWAIN-
compliant software application, see the 1S-52
——

Reference Guide.

2 . Click the Capture Image button.

Click! —

3. Click the Custom button.

Click!

4. Click the White Level button. o
ick!

5. Set the white level calibration sheet.
1 Slide the paper guide completely to the left.

2 Align the white calibration sheet with the right side of the sheet
feeder and insert it into the printer until it stops.

3 Slide the paper guide to the left edge of the sheet.

* Make sure that the paper thickness lever is set to the up
posittion.

19



6. Click the OK button.
e The white level calibration sheet feeds into the printer. When the

sheet is ejected, white level calibration has completed. @]
I

Click!

—‘i_\} Lawd wohsbe coltraban shesl.

7. Click the Cancel button, then click the Back button to
return to the main menu.

C3 Scan the original photograph >

Now you are ready to use the Scanner Cartridge installed in the printer to scan the original
photograph.

l. Click the Capture Photo button.

Click!

S
:

2 . Setthe original in the scanning holder.

3. Set the scanning holder with the original in the Sheet
Feeder.
1 Slide the paper guide completely to the left.

2 With the closed end of the scanning holder pointing down and the
original facing up, align the scanning holder with the right side of
the Sheet Feeder.

3 Slide the paper guide to the left edge of the scanning holder.

4. Click the Scan button.
® You can start the scanning job here without making any settings.

e The Sheet Feeder feeds the scanning holder in small increments as
it scans the original.

e The scanned image is displayed in the Preview Area.




Using the Scanner Cartridge

( ﬁ Saving the scanned image )
You can select a portion of the scanned image, name it, and save to a file. o >
ICK! c
£
. Select the portion of the scanned image that you want to a
save. If you want to save the entire image, you can skip
this step.
e Use the black handles on the corners and sides of the selection
box to resize the selection box.
Click the Save button.
——

e The Save As dialog box opens.

T (1|
3. Enter a name for the file and click the Save button. :'-""‘“_‘I:__ A1 ol 8l
e The area you selected in Step 1 is saved to the file. ph
s
i i
i i I"- Ty II
|
Click!
C5 Install the BJ Print Head and print the image )
To print the scanned image, you must remove the Scanner Cartridge and re-install the BJ Print

Head.

1.

2.

Open the front cover.
e The Scanner Cartridge moves to the centre automatically.

Remove the Scanner Cartridge and store it

in the storage container.

1 Raise the lock lever and remove the Scanner
Cartridge.

2 Place the Scanner Cartridge in the storage
container.

Install the BJ Print Head.

1 Install the BJ Print Head in the BJ Print Head holder where you
removed the Scanner Cartridge.

2 Lower the lock lever to lock the BJ Print Head in place.

Close the front cover.

21



5. Set the media in the printer.

e For details about loading paper in the sheet feeder,
see Chapter 3.

6. Start the print job.
1 Click the Print button.
Click!

2 Click the Printer Settings button. Py b
_:J Bl -

g T P g s B

Clickt —| memtmms [ ] e |

3 Click the Properties button.

Click!

4 Inthe Choose Print Mode box click SuperPhoto, select the Media
Type and click the OK button.

Click!

Click!

5 Click the OK button.

Click!

6 Make sure that the POWER/ERROR lamp lights green, then click
the Print button to start printing.

e \When the media is ejected from the printer, printing has

completed. o I

Clistt —werspmr ([ om ]| oo |

7 ToexitlS San Plus, click the Exit button.

Click!
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Using the Scanner Cartridge

(2 Perform white level calibration )

The first time that you use the scanner, you must perform white level calibration with white

(@]
calibration sheet provided with the Scanner Cartridge. White calibration defines the base color =
white for the computer. E

] ] Mian BH-ENE Radder H]
1. Double-click the IS Scan BIJC-8200 icon. - -
- e |f you want to use IS Scan from within a TWAIN L;'ﬂ - ..E.-'.';ﬂ_ .t?J
compliant software application, see the 1S-52
Reference Guide. =
——
Double-Click!
- e ¥
2 . Click the Menu button and select Settings from the pop-
up menu.
Click!
3. Click the White Level button. i

4. Insert the white calibration sheet in the printer.
1 Slide the paper guide completely to the left.

2 Align the white calibration sheet with the right side of the sheet
feeder and insert it into the printer until it stops.

3 Slide the paper guide to the left edge of the sheet.

e Make sure that the paper thickness lever is set to the up
posittion.

i- & T i i -

5. Click the OK button.

e The white level calibration sheet feeds into the printer. When the
sheet is ejected, white level calibration has completed.

Click!

6. Click the Cancel button.
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Scan the original photograph

Now you are ready to use the Scanner Cartridge installed in the printer to scan the original
photograph.

Click the Menu button and select Settings from the pop- -";"""'I _ e
up menu.
Click! — i
@

Click Paper Size and select A5 from the pop-up.

Ok —== (i —

EE e T oy —— ]
e g D

s

Click the OK button.

\
Set the original in the scanning holder. Click!

Set the scanning holder with the original in the sheet
feeder.

1 Slide the paper guide completely to the left.

2 With the closed end of the scanning holder pointing down and the

original facing up, align the scanning holder with the right side of
the sheet feeder.

3 Slide the paper guide to the left edge of the scanning holder.

Click the Scan button. v |

e The scanning holder feeds in small increments as the original is
scanned.

® The scanned image is displayed in the Preview Area.




Using the Scanner Cartridge

(4 Saving the scanned image )

You can select a portion of the scanned image, name it, and save to a file.

Click!
==

o))
=
=
=
=
o

l. Select the portion of the scanned image that you want to
save. If you want to save the entire image, you can skip
this step.

e Point to one of the corners or sides of the selection box, and when
the pointer changes shape, drag in any direction to resize the area.

2 . Click the Save button.

e The dialog box opens so you can select a folder and enter a file
name for the image that you want to save.

3. Enter a file name and click the Save button. - AT
e The area you selected in Step 1 is saved to the file. |

Clickl — === 1

4. Click the Close box to close IS Scan.

N\

<5 Install the BJ Print Head and print the image

To print the scanned image, you must remove the Scanner Cartridge and re-install the BJ Print
Head.

l . Open the front cover.
e The Scanner Cartridge moves to the centre automatically.

2 . Remove the Scanner Cartridge and store it in the
storage container.
1 Raise the lock lever and remove the Scanner Cartridge.

2 Place the Scanner Cartridge in the storage container.

25



3. Install the BJ Print Head.

1 Install the BJ Print Head in the BJ Print Head holder where you
removed the Scanner Cartridge.

2 Lower the lock lever to lock the BJ Print Head in place.

4. Close the front cover.

5. Set the media in the printer.

e For details about loading paper in the sheet feeder,
see Chapter 3.

6. Start the print job.

1 Open the image that you saved from the software application such
as SimpleText.

2 From the File menu, select Print.
3 For the Print Mode, select Photo.
4 For the Media Type, select the media that you set in the printer.

5 Make sure that the POWER/ERROR lamp lights green, then click
the Print button to start printing.

¢ \When the media is ejected from the printer, printing has
completed.

7 . Close the software application.
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Printing a photograph from a digital camera

Printing a photograph from a digital

camera o
=
This section describes how to print a photograph taken with a digital camera. In order to print a E
photograph from a digital camera, you must select the correct setting in the printer driver for printing
a digital image. Follow this procedure to print a photograph taken with a digital camera.
[—

Summary of the procedure for printing a digital photograph

Here is a brief summary the general steps required to print a photograph taken with a digital
camera.

Digital camera resolution?

1 . .. The resolution of photographs
Acquire the photograph from the digital cgmera taken with a digital camera
and save it. e, depends on the capabilities of

- the camera. The greater the
number of pixels that a camera
can use to capture an image, the

- better the resolution and detail in
the photo image. A digital
2 camera is graded with a number
L . according to the number of
Set the media in the printer. pixels it can use to reproduce an
image: 350,000, 600,000
850,000 pixels) or 1.31 million

3 pixels

Perform the settings in the printer driver.

4 Canon PowerShot A50
1.31 million pixels

Print the file.

Now let’s print a digital photograph.

27



28

Save to a file the photograph taken with the digital camera

Use the software application provided with the digital camera to capture the photograph and
save it to a file. For details about downloading a photograph from the camera and saving it to a

file, refer to your digital camera instructions.
Set the media in the printer

e For details about loading paper in the printer, see Chapter 3.

(3 Perform the printer driver settings

In order to print a photograph taken with a digital camera at the best possible quality, you must

select the :'.5 (Camera) icon for the Print Mode in the printer driver.

. . . P Wl e i G S
1. Open the software application. From the File menu, B
select Print. =l
e The Print dialog opens. oo

e |f the BJC-8200 is not selected, click the Name down-arrow and
select Canon BJC-8200 from the drop-down list.

Clicl

s HE
| |
; :  —
2 . Click the Properties button. o iy (=1}
® The printer driver Properties dialog box opens. iy b S
o e
PR FTET

k!

— Click!

Click!

3. Click the = (Camera) icon for the Print Mode and
select the Media Type for your print job.

4. Click the OK button

e This completes setting the printer driver for printing the digital
photograph.

— Click!

Click!

(4 Starting the print job

The preparation for printing the photograph is complete. Now let's start printing the digital

photograph.

l. Make sure the POWER/ERROR lamp lights green then f-_.-:-'-'“
click the OK button. o
¢ The photograph begins to print. Bt

— Click!




Printing a photograph from a digital camera

(3 Perform the printer driver settings

In order to print a photograph taken with a digital camera at the best possible quality, you must
select the (Photo) icon for the Print Mode and select the media that you set in the printer.

N\
Printing -

l. From the File menu, select Print to open the Print dialog

box.
. . . L A — - n—-uﬁ
2 . Make sure that the Print dialog is for the BJC-8200. e Kl 0 Y —
e |f any other Print dialog is displayed, from the Apple menu, select [ Sii— -'"H'- - 1T
Chooser then select BJC-8200 as the printer. | "F.-E. """ ] —TI —!| Ll —
Faprvivrrd s mme E=
L RS
LT T
3. Click the (Photo) icon for the Print Mode selection. o [ P 3w [ 1-"’?"".--.
e The current settings for Photo selection are displayed. _%::__I Euﬂ ll
Click! i S - e —
e — L R
i
A — _Mﬁ
4. For the Media Type, select the media that you set in the e 0 el B L O 5
: BT ] -
printer. = = = R
o This completes setting the printer driver for printing the Click! — = allin o e
photograph. T )
"} M it
e
e |
( 4 Starting the print job )
The preparation for printing the photograph is complete. Now let's start printing the digital
photograph.
Click!
1. Make sure the POWER/ERROR lamp lights green then o =l
click the Print button. ..,__...,.' = j._..!l - T
e The ph ' int. T T— s T =
e photograph begins to print | :-.:_._, ) i =
e L RS
[1 e
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2 Using the Printer Driver

This chapter describes the printer driver options which are available for setting up a variety of print
jobs. We will show you how to open and use the printer driver and explain its basic features.

What is a printer driver?

The text and image data file you create with a software application on a computer cannot be sent to the printer and printed as
it is. The printer driver provides the required link between the software application and the printer. The printer driver converts
the data created by the software application to a format that the printer can understand, and then sends it to the printer. The
printer driver also provides many useful features that you can use to set up special print jobs.

@ e Separate printer drivers are provided for Windows and the Macintosh.

Operation Flow

Here is a summary of what is presented in your hands-on introduction to the printer driver. As you
read this chapter, open the printer driver and perform the steps described in the procedures so you
become familiar with these tasks.

Opening the printer driver ([ = H
l!_l ]

v o =
T

Selecting printer driver options

- _—

Choosing a print mode

-

Selecting a media type

- =

Changing the page size

v YV U U U

Now let's examine the features and use the printer driver.

WLl —— > P.31
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Using the Printer Driver

Cl Opening the printer driver )

Follow this procedure to open the printer driver. In this example we will show you how to open
the printer driver from WordPad provided with Windows.

1. start WordPad.

e Click the Start button, point to Programs, point to Accessories, and
then click WordPad.

| T — 6
2. From the File menu, select Print. iy -g
e The Print dialog box opens. "'E ¥l ok 5

ICK!

* The name and appearance of this dialog box may differ slightly, i c
depending on your software application. For details refer to your Treear—— 6—__
software application manual. R —— )

| £

)]

c

. . I | )

3. Click the Properties button. e = D
T T —

¢ In the Print dialog box make sure Canon BJC-8200 is selected for O (I
the printer Name. If the BJC-8200 is not selected, click the Name wdna g
down-arrow and select Canon BJC-8200 from the drop-down list. o o o

P fmaa
L ] PSR T— |
L e . e
<Printer Properties dialog box> F LU
ecccccne [ |
| P e | —

Click!

B |
=) & TR

[ T El T it
et I [ |

N
Fabg me e Py

|

e |n order to perform printer maintenance and other procedures, you can also open the printer driver from the
Windows desktop. Click the Start button, point to Settings, select Printers, right-click the Canon BJC-8200 printer
icon, and select Properties. For more details, refer to the “BJC-8200 Reference Guide” on the CD-ROM.

e \When you open the printer driver from the Windows desktop, you will see some additional tabs (Details, Sharing,
etc.) provided for performing system settings like selecting a printer port, naming devices for a network, etc. For
details about these additional tabs, refer to your Windows manual.

31



32

(2 Selecting the printer driver options )

In the printer driver you can select various options set the paper size, select the media type, set the
scale for enlargement or reduction of the printed image, adjust quality and the amount of ink used,
and so on. These options are available under the four main tabs of the Printer Properties dialog box.
This section explains how to use the three tabs Main, Page Layout, and Maintenance.

e At this step we will only present the main printer driver options. For details and descriptions of all the
options, refer to the “BJC-8200 Reference Guide” on the CD-ROM.

e Main tab

Mo | i L | g | magnst |

(Choose Print Mode R
Click the icon that describes the print job that you want to execute.
With a single click you select all the optimum settings for the print

_ job.
KMedia Type
The Media Type is selected automatically after you select the print

AN

mode. However, you can select another media manually from the
pull-down list. Make sure the setting suits the print job that you
\_ want to execute.

( Displays the setting you selected. Make sure the setting

ksuits the print job that you want to print.

. e Click the Advanced button to view the settings that
@ the print mode selection has set for you
automatically. You can also adjust these settings
(Quality, Special Effects, etc.) manually.

f Page Size

K Select a page size from the pull-down list.

il

F Bariggryre Py
e By
(TN | [ ol
e ’

I O ™ O |

Orientation
Select Portrait or Landscape.

e Maintenance tab
(s B P uO|

Printing Type
Select an option for a special print job to change the layout,
printing size, etc.

N N N AN

( Print Head Cleaning
Click the first icon to start print head cleaning and click the second

icon to start deep cleaning the print head.

R L e e R
e [ =
we— (L]

KPrint Head Alignment/Test Prints
Click the first icon to start print head alignment, and click the
second icon to print a nozzle check pattern.




Using the Printer Driver

(3 Choosing a print mode )

This step describes the print modes that are available for selection based on the content of the file that you
created with the software application. Choose a print mode that is best suited for the print job.

Chooze Print Mode:

Standard Superhnto DT Camera Diraft
=

You can create your own print modes by performing the settings you need for special print jobs and saving
the settings to a print mode file. For details about creating your own print modes, refer to the printer driver
on-line Help.

Standard

Click the Camera icon to print
photographs taken with a digital camera

L Click the Standard icon for plain text files ml| o attain the best color reproduction. This
; without photos or grgph|o images that 1 -I setting also compensates for
Slandad YU have created with a word processor. Cameg  underexposure and overexposure in the
original image.
; Click the SuperPhoto icon to print - Click the Draft icon to _print drafts S0 you can
photographs or graphic images that E. - proof-read copy, confirm layout settings, etc.
J o The Draft mode prints fast and conserves

contain gradations of color.

=]
@

SupsiPholo ink.

Click the DTP icon to print documents
created with a desktop publishing

I Using the Printer Driver

o software application, text with color
s photos, business graphics, etc. The
O1P printer driver automatically distinguishes

between text and photos or graphics and
adjusts the printing for the best results.

(4 Selecting a media type )

As explained earlier, when you select a print mode icon, the paper size, best media for the print
job, and many other settings are selected automatically for the print job. However, you do not
have to use all the settings selected for you automatically by the print mode selection. For
example, after you select SuperPhoto, Photo Paper Pro is selected automatically but you can
easily select another Media Type (Plain Paper for example). Here we will show you how to
change the Media Type setting appropriate for the type of media loaded in the printer.

l. On the Main tab, for the Media Type, click the down-arrow and select the media that you
want to use. To enable the setting, click the OK button to close the Printer Properties dialog

box.
P | o Lot | Pt et Lt e | - R | I
[ S s Py ey
_Ipl!=:"af £ I NN E & oy
L Lr . g ]
e — TR L R — - o000 .» et = . T — =4
L] b |
Bilmim e S T s P
palpm et — Click!
- = Click!
R i
&j e 1 L T
[
el amles r— P
i Ly R s
S TR )
Click!
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Printing on Plain Paper Printing on Photo Paper Pro PR-101

<5 Changing the page size

D)

You can also select a page size other than the size selected for you after selecting the print

mode.

If you do not change the settings, the page size selection in the software application is used. If
you want to change the size of the page to print on, you can select another page size in the
printer driver. This may also allow you to select a page size that is not available for selection in
the parent software application, or if you cannot select any page size in the software application.

1. Click the Page Layout tab. For the Page Size, click the down-arrow and select a page size

from the drop-down list.

e To enable the setting, click the OK button to close the Printer Properties dialog box.

[ (T Click !
[
2] !j T
o = ooooo>
N J
s Lt [ = T e Fa
il et 0
T
&d g g ey
L L
Famd ot bt e, [
T T e =
™ ] ke | [

Click!

This concludes the overview of the basic printer driver features. Experiment with some of the
other settings on your own. For details about the printer driver features, refer to the “BJC-8200

Reference Guide” on the CD-ROM
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Using the Printer Driver

Cl Opening the printer driver )

Here we will show you how to open the printer driver with Simple Text provided with Macintosh.
To start a print job to print a text or illustration created with software application, pull down the
File menu and select Print or Page Setup. This procedure opens the printer driver.

e The names of some of the menus may differ slightly with the software application that you are using. For
details, refer to the software application manual.

l. Open the Apple menu, select Chooser, then click the
BJC-8200 icon.

2 . Start Simple Text.

3. Open the printer driver.

e Open the print dialog box.
From the File menu, select Print.

e The Print dialog box opens.

I Using the Printer Driver

o Open the Paper Setting dialog box

From the File menu, select Page Setup.

e The Page Setup dialog box opens.
Click!

e Open the Utilities dialog box.
From the File menu, select Page Setup, then
click the Utilities button.

e The Utility dialog box opens. Click!

Fwi gesdcndnry
TP I el (1F R

ol essicaap 1iEE4%a
Tl gl =l d F e ey

L faag redp s cman®a
f HafH lrimid i Terdiddinis
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(2 Selecting the printer driver options

)

In the printer driver you can select various options to set the paper size, select the media type,
set the scale for enlargement or reduction of the printed image, adjust the amount of ink used,

and so on. These options are available in the three main dialog boxes of the printer driver. The

print job options are found on the three main dialogs: Print, Page Setup, and Utilities.

e Print dialog box

e At this step we will only present the main printer driver options. For details and descriptions of all the
options, refer to the “BJC-8200 Reference Guide” on the CD-ROM.

)

A B - Eeribia L1
cagmen | [T mewen @an Giwws [ |w [ ] (L)
B TR T / )
L — | T Print Mode
Il-_-'-'l_-'- . IE m IEJ IE —n Click the icon that best describes the print job that you want to
T g | execute. With a single click you select the optimum settings for the
bk i | ot 8 i e print job.
[l Pt o st e
=[S Media Type
L Click Media Type and select the media from the pull-down list.
o Page Setup dialog box
ki BT Pesdims 13 =
Fagam arm I;I% Paper Size
ick to select the paper size that you want to use for printing.
- I‘:":E"““ Click lect th ize th fi inti
5 =
T ]
| b |
O by barmg

e S

o Printer Utility dialog box

AR B R TR B 1

il Head =

[l HEFT R e T ]
L T e T e

Finlbralderpibanng

Siarin prid -bwad derp ilranmy

E fapdredmry cmamng

L

Scale
Click the select the amount of enlargement or reduction.

-

t

This dialog provides the selections for print head cleaning,
printing test prints, and other maintenance tasks. Execute
print head cleaning to correct poor print quality.




Using the Printer Driver

(3 Selecting a print mode )

The palette provides selections for a variety of print jobs. Just click the icon that suits the content
of the print job that you want to execute. Selecting one of the icons automatically selects the
print quality, color adjustment, and resolution.

Print Mode :

Current Settings : Text

The meaning of these icons is explained below. Click each icon from left to right as you read the
descriptions below. The icon name is displayed below the icon after it is clicked.

Photo
Text e :
Click this icon to print photographs or

C:Ck this icon fﬁ.r plam text Eles wutt;out graphic images that contain gradations of
photos or graphic images that you have color. Reproduces natural colors

created with a word processor. without graininess.

Manual

g{ciﬁgg(:ioon for illustrations that contain Click this icon then click Details to create
) ustrations that contal and save your own palette icon with
] sharp lines.

settings that you choose.

@ e Make sure that you select a Media Type appropriate for the print job.

(4 Selecting a media type )

Here we will show you how to select a different type of media. For whichever print mode icon
you select at Step 3, the Plain Paper is automatically selected at the first time for the print job.
Let's change the Media Type setting for the media actually loaded in the printer.

1. Click the Media Type down-arrow and select a media
type from the pull-down list.

2 . After confirming the Media Type selection, click the Print
button to execute a print job.

Click!

I Using the Printer Driver
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You can also select a paper size other than the size selected for you after selecting the Print

C5 Changing the paper size
Click! Click!

Mode.
éﬁ""' -

l . From the File menu, select Page Setup to open the

Page Setup dialog.
2 . Click the Paper Size down-arrow and select the paper = e =]
.| 7 I:E:‘ ]

size from the pull-down list.
e To enable the setting, click the OK button to close the Page Setup

dialog box.
This concludes the overview of the basic printer driver features. Experiment with some of the

other settings on your own. For details about the printer driver features, refer to the “BJC-8200

Reference Guide” on the CD-ROM.
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Chapter

Loading Paper
and Special Print Media

This chapter describes the media that you can use with the printer and how to load it. To ensure the
best performance of the BJC-8200 printer, select the suitable paper for your print job and load it in
the printer correctly.

Media that you can use with this printer

Let's examine the media that can be used with this printer and the special procedures to follow
when handling paper and special media.

e For optimal printing results, Canon recommends that you use Canon genuine media for Canon BJ printers.
@ * When you use Canon media, make sure that you follow all the instructions included with the packet. The
instructions will describe how to print on the media and how to handle and store it after printing.

Plain paper You can use plain paper (64~90 gsm) and Canon Bubble Jet Paper LC-301.

Envelopes You can use standard European DL or U.S. Commercial No. 10 envelopes with this
printer. Using envelopes of other sizes is not recommended.

I Loading Paper and Special Print Media
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Photo Paper Pro
PR-101

Thick paper coated with a glossy surface, ideal for reproducing the natural color
of photographic images. This is best choice for printing photographs with the BJC-
8200.

High Gloss Photo
Film HG-201

A film sheet with a higher gloss than glossy photo paper. Use this media to obtain
high quality reproduction of photo color. Use this media to reproduce
photographic images of highly reflective surfaces like polished metal or glass.

Glossy Photo Paper
GP-301

Covered with a gloss coating on the print side of the sheet to provide near-
photographic quality with the gloss feel of a photographic print. This media is
slightly heavier than High Resolution Paper.

High Resolution
Paper HR-101

Coated paper that produces colors more vivid than with plain paper. Ideal for
printing photographs or business documents that include large numbers of color
illustrations and graphs.

Glossy Photo Cards
FM-101

A special card of the same paper stock as Glossy Photo Paper GP-301. Print over
the perforated borders then remove the borders to trim away unwanted white
margins. Use this media when you want to print an image over the entire card.

e For details about loading the creative media (Transparencies, Banner Paper, and T-Shirt Transfer)
refer to the “BJC-8200 Reference Guide” on the CD-ROM.

Transparencies
CF-102

Use to prepare presentations for an overhead projector. Never attempt to use
photocopier or laser beam printer OHP film with this printer.

Banner Paper
BP-101

Allows you to print on up to six connected sheets of A4 or Letter size paper to
create a party or advertising banner. The composition of banner paper is identical
to Bubble Jet Paper LC-301.

T-Shirt Transfer
TR-201

Use this media to produce your original T-shirt. Print the image of your favorite
photograph onto the transfer and apply the transfer to the T-shirt with a hot
household iron. When you select T-Shirt Transfer as the Media Type in the printer
driver, the original image is reversed, or mirrored, so it is displayed correctly after
applying the transfer to the T-shirt.
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Paper thickness

Loading Paper and Special Print Media

Here are some important points to keep in mind when selecting paper for the printer.

Automatic feed or manual feed

Feed Method Thickness Range

Comment

Sheet feeder 64~90 gsm

Manual 90~500 gsm

Load plain paper or other media that is within this range of
thickness.

Load plain paper or other media thicker than 90 gsm but not
thicker than 500 gsm (less than 0.6 mm). You can also load any
media manually that falls within the range for Auto Feed.

® To avoid jamming the printer and other problems, never load paper thicker than 0.6 mm in the manual

feed slot.

Paper or media you should never load in the printer

Here is a list of the types of paper or other media that you should never load in the printer. The
following media will not only result in poor print quality but could also jam or damage the printer.

« Folded paper
« Excessively curled paper
« Wrinkled or warped paper
« Damp paper

« Excessively thin paper (thinner than 64 gsm)

« Excessively thick paper (thicker than 0.6 mm)

« Paper with pasted photos, stickers, etc.
« Envelopes with flaps overlapping

« Envelopes with self-sealing flaps

¢ Tractor feed paper

« Perforated paper

¢ Punched paper

« Paper with any type of fasteners, ribbons, etc. attached

Load limit and Paper Thickness Lever position

Media Type Sheet Feeder Load Limit Paper Thickness Lever
Plain paper 100 sheets (64 gsm) Up
Photo Paper Pro PR-101 1 sheet Up
High Gloss Photo Film HG-201 1 sheet Up
Glossy Photo Paper GP-301 10 sheets Up
High Resolution Paper HR-101 80 sheets Up
Glossy Photo Cards FM-101 1 sheet Up
Transparencies CF-102 10 sheets Up
Banner Paper BP-101 1 sheet (2~7 pcs. connected) Down
T-Shirt Transfer TR-201 1 sheet Up
Envelopes (European DL or U.S. No. 10 Commercial) 10 pcs. Down

I Loading Paper and Special Print Media
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Setting media correctly

Follow the instructions below to load the paper in the printer.

e For details about loading Transparencies (OHP film), T-Shirt Transfer, and Banner Paper, see the
“BJC-8200 Reference Guide” provided on the CD-ROM.

Loading Photo Paper Pro PR - 101

Raise the paper thickness lever to the |- mark.

Raise the paper rest, lower and pull out the paper output
tray.

Slide the paper guide completely to the left.

Set the Roller Cleaning Plate (provided with the printer)

into the Sheet Feeder.

e With the patches up and pointing down, align the Roller Cleaning
Plate with the right side of the sheet feeder.

¢ The Roller Cleaning Plate is used to load Photo Paper Pro as well
as clean the paper rollers.

With the glossy side facing up, place the sheet of Photo
Paper Pro on top of the Roller Cleaning Plate, align the
sheet with the right side of the sheet feeder and insert
the sheet into the printer until it stops.
- * Handle media carefully by its edges. Never touch
the print surface (the g{oséy sidegof the sheets).
Dirt or fingerprints on the print surface will
adversely affect print quality.

e You can load only 1 sheet of Photo Paper Pro in the
@ sheet feeder.

Move the paper guide to the left edge of the sheet.



Loading Paper and Special Print Media
Loading plain paper or High Resolution Paper HR - 101

Raise the paper thickness lever to the |_. mark.

Raise the paper rest, lower and pull out the paper output
tray.

Fan the edges of the sheets to remove static cling. Tap
the edges of the stack against a flat surface so the stack

is aligned.
e To prevent paper jams, always fan the sheets and
align the edges before you load them in the sheet

feeder.

e Handle media carefully by its edges. Never touch
the print surface of the sheets. Dirt or fingerprints
on the print surface will adversely affect print
quality.

¢ \When you use the High Resolution Paper, do not
touch the whiter print side.

Slide the paper guide completely to the left.

With the whiter side facing up, align the stack with the
right side of the sheet feeder and set the stack in the
printer.

@ e You can load up to 100 sheets (64 gsm) of plain paper

Whiter Side

or 80 sheets of High Resolution Paper in the sheet
feeder at one time.

I Loading Paper and Special Print Media

¢ Do not allow plain paper and High Resolution
Paper to stack higher than 50 sheets on the paper
output tray.

e To prevent warping and bending of the paper, do
not leave High Resolution Paper set in the sheet
feeder for a long time.

e |f you print on the paper wider than 216 mm, make
sure you select the Envelope for the Media Type
on the printer driver.

Slide the paper guide to the left edge of the stack.
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Loading High Gloss Photo Film HG - 201

Raise the paper thickness lever to the . mark.

Raise the paper rest, lower and pull out the paper output
tray.

Slide the paper guide completely to the left.

With the print side facing up, align a sheet of High Gloss L]
Photo Film with the right side of the sheet feeder and
insert the sheet into the printer until it stops.
- ¢ Handle media carefully by its edges. Never touch
the print surface of the sheets. Dirt or fingerprints
on the print surface will adversely affect print
quality.
® You can load only 1 sheet of High Gloss Photo Filmin
@ the sheet feeder.

e | oad the sheet of High Gloss Photo Film with the cut
corner in the upper right corner to ensure that the
correct print side is facing up.

Move the paper guide to the left edge of the sheet.



Loading Paper and Special Print Media
Loading Glossy Photo Paper GP - 301

Raise the paper thickness lever to the |_. mark.

Raise the paper rest, lower and pull out the paper output
tray.

Slide the paper guide completely to the left.

Set the Roller Cleaning Plate (provided with the printer)

into the Sheet Feeder.

¢ With the patches up and pointing down, align the Roller Cleaning
Plate with the right side of the sheet feeder.

e The Roller Cleaning Plate is used to load Glossy Photo Paper as
well as clean the paper rollers.

With the glossy side facing up, place the sheet of Glossy

Photo Paper on top of the Roller Cleaning Plate, align

the sheet with the right side of the sheet feeder and

insert the sheet into the printer until it stops.

e |f you load more than one sheet, fan the shgets to
remove static cling and tap the edges against a
flat surface to align the sheets.

e Handle media carefully by its edges. Never touch
the print surface of the sheets. Dirt or fingerprints
on the print surface will adversely affect print
quality.

® You can load up to 10 sheets of Glossy Photo Paper in
the sheet feeder.

I Loading Paper and Special Print Media

Move the paper guide to the left edge of the sheet.
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Loading Glossy Photo Cards FM - 101

Raise the paper thickness lever to the . mark.

Raise the paper rest, lower and pull out the paper output
tray.

Slide the paper guide completely to the left.

With its glossy side facing up, place one Glossy Photo

Card on top of the Loading Support Sheet <A> provided

with the pack of Glossy Photo Cards and align both

sheets.

® Make sure that the Loading Support Sheet <A> is pointing down in
the direction of the arrow.

¢ To avoid jamming, never load a Glossy Photo Card
@ that is curled or bent, and confirm that the edges of the
card and the Loading Support Sheet are aligned
before setting them in the printer.

Align the stack with the right side of the sheet feeder and
insert it into the printer.

Slide the paper guide to the left edge of the stack.
® To prevent a paper jam, make sure the sheets are
straight and flat in the sheet feeder.

e Handle media carefully by the edges. Never touch
the print surface of the sheets. Dirt or fingerprints
on the print surface will adversely affect print
quality.

e You can load only 1 Glossy Photo Card in the sheet
feeder.

Loading Support Sheet




Loading Paper and Special Print Media

Loading Envelopes

Lower the paper thickness lever to the == mark.

Lower and pull out the paper output tray.

Prepare the envelopes for loading in the sheet feeder.

* Make sure that none of the flaps are overlapping.

e |f the edges of the envelopes are not sharp,
crease them with the side of a pen or biro.

® Press down on the corners and sides of the
envelopes to make them as flat as possible by
expelling all the air inside the envelopes.

e To avoid paper jams, make sure the envelopes are
flat before you load them in the sheet feeder.

Slide the paper feed guide completely to the left.

With the return address facing up and pointed down,
align the stack with the right side of the sheet feeder and
insert the stack in the printer.

e You can load up to 10 standard European DL or U.S.
@ Commercial No. 10 envelopes in the sheet feeder.

* Do not allow more than 10 envelopes to stack on the
paper output tray

Slide the paper guide to left edge of the stack.

I Loading Paper and Special Print Media
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Other media for creative printing

In addition to the paper and special media described in previous sections, the following special
media are available.

e For detailed instructions about loading, printing, and special procedures for each media described below,
refer to the “BJC-8200 Reference Guide” on the CD-ROM.

Transparencies CF-102

For impressive presentations!
Use Transparencies CF-102 to create colorful OHP film presentations.

T-Shirt Transfer TR-201

Create original T-shirts!
Use T-Shirt Transfer to transfer colorful designs and photographs to cotton T-
shirts. Create a design in a graphics software application, scan or capture
photograph from a digital camera and print the image in the T-Shirt Transfer. By
transferring the image to a T-shirt with a household iron, you can create original
designs.

Banner Paper BP-101

Create decorative banners for parties or business!
Use these continuous sheets (connected by faint perforations) to print banners up
to 1.8 metres long (6 sheets of A4 width).
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Chapter

4 Troubleshooting

Refer to this section if you experience problems with the printer. This chapter provides solutions for
some of the most common problems you could encounter with the printer.

Reference

¢ |f you do not find a description of the problem and a solution, refer to the Troubleshooting section of the
“BJC-8200 Reference Guide” on the CD-ROM.

Here is an overview of what is described in this chapter.

Cannotinstall the printer or scannerdriver . .............. ..., 50
Printer prints meaningless charactersandsymbols ...................... 51
Cancellinga printjob .. ... 52
Printingon athick paper . ........... e 53
PapEr JAMS . .. 54
Lowinkalert . ... ... 56
Printer beepsanditdoesnotprint .......... ... .. ... . . i, 57
Error message appears . .. ..ot e e 58
Printing quality is unsatisfactory ............... ... i 60
AdJUSEING COIOT . . .. e 66

Aprintoutisunclear, faded ......... ... ... . 67
COolOr IS StrANgE ..ottt 75

Scanner Cartridge does notoperatecorrectly ........................... 76
Whenconnected ViaUSB .. ... . 76
Replacingthe BJPrintHead ... .......... .. ... . 77

Troubleshooting -
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Cannot install the printer
driver or the scanner driver =223

Check the following items if you cannot install the printer driver or the
scanner driver. If you must re-install either driver, note the following points.

Always uninstall the current printer driver before installing it again.

e For details about uninstalling the printer driver, refer to the "BJC-8200 Reference Guide" on the CD-ROM.

You do not need to uninstall the current printer driver before re-installing the printer driver.
Use the Easy install method to re-install the printer driver.

Make sure the driver was installed correctly
Refer to the “Quick Start Guide” and install the printer driver using the correct procedure.

e |f an error occurred and you forcibly shut down the installation, you may not be able to install the printer
driver because the operating system is no longer stable. Restart the computer and then install the
printer driver again.

Other software applications are running in the background
Quit all other software applications that are running in the background and start the installation again.

Make sure that the drive holding the CD-ROM was specified correctly

After you set the CD-ROM in the CD-ROM drive, normally the setup screen opens automatically. If the initial screen does
not open automatically, double-click the My Computer icon and double-click the CD-ROM icon. Follow the instructions in
the “Quick Start Guide” complete the installation of the printer driver.

Normally as soon as you set the CD-ROM, the contents of the CD-ROM are displayed. If the contents are not displayed,
double-click the CD-ROM icon. Follow the instructions in the Quick Start Guide to install the printer driver.

Confirm that the CD-ROM is operating normally

Use Windows 95 or Windows 98 Explorer to confirm that the CD-ROM is operating normally. If the Setup Software &
Reference Guide CD-ROM that you received with the printer is unreadable, call for service.

Use the Apple System Profiler, click the Device and Volumes tab, and test whether or not you can open the CD-ROM.



Printer prints meaningless characters and symbols

Printer prints meaningless Q9?9
characters and symbols A

Ly e

Check the items below if the printer prints bizarre, meaningless characters. E

Confirm that a previous print job was not paused before it finished.

If the previous print job was paused before it finished, switch off the printer and computer. Switch on the printer and
computer again.

¢ To determine if any suspended print jobs exist in Windows, click the Start button, point to Settings, and
click Printers. Double-click the Canon BJC-8200 icon. If any unfinished print jobs are listed, cancel them.
For details about cancelling a print job, refer to your Windows manual or on-line Help.

Confirm that the correct printer driver was selected for the print job.

Start the print procedure again and make sure Canon BJC-8200 is displayed in the Name entry box of the Print dialog.
Meaningless characters and symbols may be printed if you are using other printer drivers.

e To avoid this problem, you may want to select the printer as the default printer. For details, refer to the
“BJC-8200 Reference Guide” on the CD-ROM, your Windows manual, or Windows on-line Help.

51
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Cancelling a print job

This section describes how to cancel a print job immediately after it has

been started.

- ¢ More than one method can be used to cancel a print job, using the BJ
Reference

Backgrounder, BJ Print Monitor, and so on. For details about all the

methods for cancelling a print job, see the “BJC-8200 Reference Guide”

on the CD-ROM.

( Cancelling a print job while the computer is sending the printing data to the printer )

The BJ Backgrounder dialog box is displayed on the screen while printing data is being sent to
the printer. Follow this procedure to cancel the print job with the BJ Backgrounder:

l. During printing, rapidly press the POWER button twice.

e The print job is cancelled and the paper is ejected.

2 . Ifthe screen to the right displays, click the Cancel
button.

3. Click the OK button.

1 . During printing, rapidly press the POWER button twice.

e The print job is cancelled and the paper is ejected.

2 . If the message to the right is displayed, click the Stop
button.

e [f the screen to the right is displayed, press and hold down
the Command key then press the period key (.) to cancel the
print job.
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Printing on a Thick Paper

Printing on thick paper
When you print on thick paper, feed manually from the manual feed slot in
the back of printer.

Setting thick paper for printing

Make sure the printer is switched on and lower the paper

| o |

thickness lever to the =" mark.

Lower and pull out the paper output tray.

With the print side up, carefully align the sheet with the
left side of the manual feed slot, insert the sheet until the
printer grabs it and feeds it partially.

In the printer driver, select the setting for thick paper.

On the Main sheet select Other Paper for the Media Type. When the
message asks you to confirm your selection, click the OK button.

" Click! .
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In the Print dialog box select Other Paper for the Media Type. When ey Pt e -g
the message asks you to confirm your selection, click the OK button, = * [ = =] [ 2] S
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Paper Jams

Follow the procedure below to clear a paper jam.

Paper or media jammed during auto feed

Remove the paper from the sheet feeder.

Pull the jammed sheet slowly out of the feed slot or the
paper output slot, whichever is easier.

e |f the paper tears and some of it is left in the printer,
@ switch the printer off, open the front cover and remove

the paper fragments.

o |f the paper will not pull out of the printer easily, do not
force it.

e |f you cannot remove the jammed paper, press the
POWER button twice to eject the jammed paper
automatically.

e Start the print job and try again. If you have switched
printer off, the print job data has been lost. You will
have to start the print job again.

e Use A5 size paper only for printing text. To avoid
excessive curl and jamming the paper output, we do
not recommend using A5 paper to print photographs
or graphic illustrations which require large amounts of
ink.

Set the paper in the sheet feeder and press the
RESUME button.

Paper jam!




Paper Jams
Paper jammed during manual feed.

Pull the jammed sheet slowly out of the manual feed slot
or the paper output slot, whichever is easier. O

e |f the paper tears and some of it is left in the printer,
@ switch the printer off, open the front cover and remove

the paper fragments. N

e |f the paper will not pull out of the printer easily, do not
force it.

e |f you cannot remove the jammed paper, press the
POWER button twice to eject the jammed paper
automatically.

e Start the print job and try again. If you have switched
the printer off, the printer job data has been lost. You
will have to start the print job again.

e Use A5 size paper only for printing text. To avoid
excessive curl and jamming the paper output, we do
not recommend using A5 paper to print photographs
or graphic illustrations which require large amounts of
ink.

Set the paper in the manual feed slot and press the
RESUME button.

Troubleshooting
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Low ink alert

When the ink supply becomes low in an ink tank, Windows displays a low 2
ink alert with the BJ Status Monitor and Macintosh displays the low ink A s
alert with the BJ Print Monitor. After the low ink alert is displayed, youcan =
continue printing, but you should replace the empty ink tank as soon as

possible. Ink runs low!

¢ When an ink tank becomes empty, the printer beeps, the POWER/ERROR lamp lights orange, and
printing halts. In this case, you cannot continue printing and you must replace the empty ink tank.
After the ink tank is replaced, the printer will automatically clean the print head and the
POWER/ERROR lamp will flash. When the lamp stops flashing and lights green, ink tank replacement

is completed. For details about replacing an ink tank, see “Replacing an in tank” in this “User's
Guide”.

Read the BJ Status Monitor message and click the Ink Information tab to confirm where the ink
supply has run low.

1 s B Fard e ks Hewies - 1IP0Il E

TSN o e ey TR P mEE

e P Hot irery e Heo
[Pari T | b | e i | es00 '» Pk i | e [ i |

== I

B b e oD )
Open the BJ Print Monitor to confirm the low ink alert.
] EiFneibkrier A1 ]
m] @ 2] [ M by B Ink tanks displayed here run low.
P S
@ v Page B0, Comarn ¢ 8%, Bl i | LE <D | |
! — — — e When Backgrounding is off, you
. ; . @ cannot open the BJ Print Monitor.
If the low ink alert occurs, the
Status dialog displays
T automatically with the ink low

warning.



Printer beeps and it does not print

Printer beeps and it does
not print

When an error occurs, the POWER/ERROR lamp will light or flash orange
and the printer will beep. Count the number of beeps and identify the
problem in the table below. Press the RESUME button and count the
number of beeps.

@ e Press the RESUME button and count the number of beeps.

Cause Solution

Setting media correctly (P.42).
Paper out, paper jam, | Setthe paper correctly. If the paper has jammed in the printer, remove the jam and press
paper feed error. the RESUME button for normal operation. (P.54)

HECEE e Setting media correctly (P.42)

Remove the jam and press the RESUME button to resume normal operation.

Paper jam.
HEGCS) o Paper Jams (P.54)

Replace the empty ink tank.

Ink tank out of ink.

GHEEE e Replacing an ink tank (P.74)

Install the BJ Print Head. If already in place, remove it, check the sensitive electrical

BJ Print Head not contact area for any blockage or any protective tape. Put it back in properly.

installed.
HHEEE e Replacing the BJ Print Head (P.77)

Make sure the BJ Print Head is installed correctly. When you are using the Scanner

BJ Print Head not Cartridge, make sure the Scanner Cartridge is installed correctly.

installed correctry.
i HHEEE e Replacing the BJ Print Head (P.77)

If not corrected by pressing the POWER button twice, replace the BJ Print Head.
BJ Print Head

defective (HEM o Replacing the BJ Print Head (P.77)

Press the RESUME button to skip the error so you can continue printing. When the waste
ink tank becomes full, the printer will beep 10 times, the POWER/ERROR lamp will flash,
and printing will no longer be possible. Call for service to have the waste ink tank
replaced immediately.

Waste ink tank nearly

full, 2

5]

@ ® The waste ink tank holds ink used for print head cleaning. 8

%)

Switch the printer off, unplug it from its power outlet and wait a few minutes. Plug in the @

. ; ) S . o

) power again, switch the printer on and restart the print job. If the error occurs again, count S

Service error. and record the number of flashes and call for service. When you call for service you may E
be asked how many times the POWER/ERROR lamp flashed.

——
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Error message appears ™
During a print job when paper runs out, ink runs low, or paper jams, the BJ ' —L
Status Monitor, BJ Print Monitor, or your operating system displays an —

error message on the screen.
Error!

e For more details about printer errors and solving problems, refer to “Chapter 6 Troubleshooting” of
the “Printer Reference Guide” on the CD-ROM.

BJ Status Monitor and BJ Print Monitor Error Messages

The BJ Status Monitor opens and displays a message when an error occurs.

e The BJ Status Monitor uses graphics and messages to display information about the printer status and
the progress of print jobs. (The BJ Status Monitor can operate only in an environment where bi-
directional communication between the printer and computer is possible.)

e \When the BJ Status Monitor opens, read the messages and graphic alerts then click the Guide tab to

display more information about solving the problem. Follow the instructions provided by the BJ Status
Monitor to solve the problem.
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When an error occurs, a BJ Print Monitor error message is displayed. If Backgrounding has
been switched on with the Chooser, the BJ Print Monitor opens. Follow the instructions in the
message to solve the problem.

ﬁ BJC-8200 Error Number : D1000
No paper.
Load the paper correctly and press the
RESUME button.




Error message appears

Operating System Errors

If the error messages below are displayed and printing halts, this indicates a problem in your
system, so check the following items:

e |s the printer switched on?
e Are the printer and computer securely connected?
e |s the printer port operating correctly?

Common system errors include writing to LPT1: or USBPRN, application software errors, or
general protection faults.

Printers Folder (%]

There waz an emor wiiting to LPT1: for the printer [Canon BJC-8200 [Copy 3]):
The printer iz not ready. Make sure it is tuned on and anline.
To continue printing, click retr.
Windows will automatically retry after 5 seconds.

Cancel |

The Macintosh will display an Error Number: *300 message where the asterisk is replaced by a
letter of the alphabet, depending on the error.

ﬂ B Prawthdinita F EFrar Suimber @ R
A CiE A n arrar has oocurred. sk
SUre Hiak Chis princir is pluggad in,
prwared=on, and propery Connected (o
waur Computer. Thin oy primtiog again.
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Printing quality is unsatisfactory

You may be able to improve the printing quality by using the recommended paper or special media
and adjusting the color. Follow the procedures below to solve the problem.

Using the recommended paper or special media

You can significantly improve the quality of a picture or an image by using the recommended
paper or special media. Special media best suited for printing color are Photo Paper Pro PR-
101, High Resolution Paper HR-101, Glossy Photo Paper GP-301, and High Gloss Photo Film
HG-201. These special media reproduce colors better than plain paper. For details, refer to
“Loading Paper and the Special Print Media” in Chapter 3.

Changing the printer driver settings

Adjusting the print mode settings
Adjust the print mode settings to create a sharper image.

1. Open the printer driver, select the Print Mode i oo RO
on the Main sheet, and click the Advanced L L'_Jn &y
button. o ————

= T e il e |

-] :"‘_ [yesmy ([

";_'-_5_‘\ e |

2. Drag the Print Quality slide bar to the Fine R - L Lot
setting. Clickl ——{(mmm )= F—=1)
—1 - =
—— F

EECR s
i
I - I i —

Print Quality set at Fast Print Quality set at Fine
= g—
i




Printing quality is unsatisfactory

Improving print quality with the Photo Optimizer

The desired natural color image may not be reproduced in the printed image depending on the conditions under which
you took a photograph. For realistic color reproduction, use the Color Optimizer feature. The Color Optimizer adjusts
color balance automatically if the image data color is unsatisfactory.

@ e When Camera is selected for the Print Mode, the Photo Optimizer is automatically selected.

1. Open the printer driver and click the
Advanced button on the Main tab.

2 . On the Quality sheet, click and check on the ]
Photo Optimizer box. —

= B g ci

[ |

With Photo Optimizer

Without Photo Optimizer

B - A

—

By

AR o L ay,

Adjusting the Detailed Setting
Improve the printing quality by adjusting the Detailed Setting.
For a sharper image, you can adjust options in the Detailed Setting.

Click!
l. Open the Print dialog box, click the 2] (Manual) icon, .g
and click the Details button. =
D
9
o]
>
T e
. B Loy . . . ma - —
2 . Click th(_e = (Quality) icon, move the Print Quality slide m|
bar to Fine. =
g|— = N
B I
P N0 | B
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| Aligning the print head

N\

If the printed image appears blurred or uneven, aligning the print head could solve the problem.
To align the print head correctly, you will need one sheet of High Resolution Paper.

Before aligning the print head

Before aligning the print head

“iaciniosh R
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After aligning the print head

After aligning the print head




1.

Make sure that the printer is switched on, raise the paper
thickness lever to the | | mark, and set one sheet of
High Resolution Paper in the sheet feeder with its whiter
side up.

Click the Start button, point to Settings then select
Printers.

Right click the Canon BJC-8200 icon and then select
Properties.

Click the Maintenance tab then click the J (Print  Click!
Head Alignment) icon.

Click!

Read the message and click the OK button.

Clickt —————— () = |

Read the message and click the OK button.
e The print head alignment pattern starts to print.

Click! —'E _= |

7. While looking at the printed print head alignment pattern,

enter the numbers in the Print Head Alignment dialog
box.

Click the OK button.

® Print Head Alignment is now complete.

¢ For details, see “Reading the print head alignment
pattern”. (P.65)

Click!

Printing quality is unsatisfactory
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1.

Make sure that the printer is switched on, raise the paper
thickness lever to the | | mark, and set one sheet of
High Resolution Paper in the sheet feeder with its whiter
side up.

In the software application, from the File menu, select
Page Setup.

Click the Utilities button.

Click the down-arrow to select Test Print.

Whiter side

T = A

Click the J (Print Head Alignment) icon. }
Click!

Read the message and click the OK button to continue.
¢ The print head alignment pattern starts to print.

While looking at the print head alignment pattern, enter
the numbers in the Print Head Alignment dialog box.

® For details, see “Reading the print head alignment
pattern”. (P.65)

-
| Prer b ol o

Click the Send button.
¢ Print Head Alignment is now complete.
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Printing quality is unsatisfactory

" Reading the print head alignment pattern )

After the print head alignment pattern prints, follow the guide below to select and enter the
numbers to adjust the print head.

« Click the up or down-arrow in the spinboxes to select a

Id_lvh.l_
number.

T e — -

W Horizontal Alignment
For (A)~(E) select the number for each column where the

s e s e ey o e
: pattern appears clearest and smoothest.
If you cannot decide which numbers to enter, use the
- selection method below.
— 4 * For (A), (B), (C) try to select the acceptable patterns with
E the highest numbers.
l » For (D) select the same number entered for (A) Black.
» For (E) select the same number entered for (B) Cyan.
Bl-directional Alignment
Enter the number of the pattern where the vertical white
streaks are the least obvious. If you cannot decide on a
selection, enter the acceptable pattern whith the lowest
number.
R R RN
N RGN
Uneven N - HiR
_ NN T R
Most even I S e
it P————
Uneven | ..
- [ RS 4
O
o
N T e £
o
White streaking obvious 2
IWHEETD a
(A i 2
No white streaking e 5
e — :
White streaking obvious S
AR e
[EEH EREI L | —
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Adjusting color

You can adjust color by adjusting the Color Balance, Output Style, and
Brightness.

e Make major color adjustments with the application software and use
@ the printer driver options only for fine color adjustment.

1. Open the printer driver and click the [P | a—
Advanced button on the Main tab. i
N 5 CAPIEE:
b - )
[ T L 0 gl =y
P —
D::I-HH- iip :"' :
Click! Click!
2 . Click the Color tab and click the Color Adjustment ’ e —
check box to enable the Color Balance, Output Style, B B [—
i N e e
and Brightness. T
; e For details about Color Adjustment, Output Style, or it =" 9
Brightness, refer to the on-line Help. b o= -
- v H — =
. 5
[ || ] Bt e

1. Open the printer driver, click the | 2] (Manual) icon and

click the Details button. e _
Click!l . E

. Click the [ B (Color) icon.

3. Inthis dialog you can adjust the settings for Color i,
Correction, Matching Method, Gamma Correction, and o e
Color Balance. g —— e




A printout is unclear, faded

A printout is unclear, faded

The following conditions could cause unclear or faded printing.
Printed output which is faded or streaked with while could be caused by
the following conditions:

¢ Print media was not loaded with the print side up.

¢ Ink has run out in one of the ink tanks.

e BJ Print Head nozzles are clogged.

¢ The BJ Print Head is worn out or damaged.
Follow the procedures below to correct the problem.

Summary of correcting the problem

Was the media loaded with the print side up?
Special media must be loaded with the correct print side up.
Did you check the ink tanks?
Yes NO == Setthe media correctly e Fading or streaking is usually a
| sign that ink supply is low in
one or more of the ink tanks.
Check the ink level in the ink
tanks. If an ink tank is empty,
replace it.
e |f the printer beeps four times,
one or more of the ink tanks
‘ has run out of ink. Replace the
empty ink tank (s).

T

Ink tank(s) out of ink?
Check the amount of ink remaining in each tank. If an ink tank is empty, replace it.

Yes No =P Replace the empty ink tank

BJ Print Head nozzles clogged or damaged?

If printed images are faded in spite of a sufficient ink supply, the nozzles of the print

head could be clogged or the BJ Print Head could be wom or damaged. Did you check the level in the ink
I tanks?

Y
1 Windows

. e In the BJ Status Monitor, click
Print a nozzle check pattern. (P.68) the Ink Information tab and

| check the level in the ink tanks.
Y e If you cannot display the BJ
2 Status Monitor in your system,

open the front cover and

Clean the print head. (P.70)

If the nozzle check is not crisp and clear, clean the print head and print another
nozzle check pattern.

{

Execute print head deep cleaning. (P.72) if alow ink alert is displayed. =
If the nozzle check pattern is not crisp and clear, perform print head deep e |f you cannot display the BJ 'g
cleaning and print another nozzle check pattern. Print Monitor in your system, 8
open the front cover and %
* remove each ink tank one by -
one to check the ink level g
visually. =
Contact the Canon Customer Care Center. You may need
to replace the BJ Print Head. (P.77)
——

remove each ink tank one by
one to check the ink level
visually.

e Open the BJ Print Monitor to see
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Printing a nozzle check pattern

The sensitive contact area of the print head that discharges the ink
contains the nozzles. When you see faded or streaked colors and text,
the nozzles may not be functioning properly. This can be caused by:
« Clogging which prevents the nozzles from discharging the ink to
the paper.
» Misalignment of the print head.
These problems can be confirmed by printing a nozzle check pattern.

1.

Make sure that the printer is switched on, then load a
sheet of plain paper into the Sheet Feeder.

. I(.;)ig;ng plain paper or High Resolution Paper HR-101

Click the Start button, point to Settings, and click
Printers.

Right-click on the Canon BJC-8200 icon and select
Properties.

Click the Maintenance tab and click the J (Nozzle
Check Pattern) icon.

* To print a nozzle check pattern with the printer
@ operation panel, press down and hold the RESUME

button until you hear two beeps then release it.

Read the message and click the OK button. The nozzle
check pattern starts to print.

¢ The BJ Status Monitor opens automatically and closes when @ e |
printing is completed.

-=l'-l,| o ey B iy iy

|
Click!

Read the message and click the OK button. Y el et st

Check the nozzle check pattern.
e |f part of pattern 1 is missing, clean the print head.

e |f pattern 2 is not smooth, or if pattern 3 is streaked vertically with o | %
white, align the print head.

& ) ¢ Cleaning the print head (P.70) S
e Aligning the print head (P.62)




1.

Make sure the printer is switched on, then load a sheet
of plain paper in the printer.

. I(_;)ig;ng plain paper or High Resolution Paper HR-101

In the software application from the File menu, select
Page Setup.

e The procedure you use to open the printer driver may
@ differ slightly, depending on the software application

that you are using.

=T TFL]

Click the Utilities button.

A printout is unclear, faded

Click the down-arrow to select Test Print. e (@ }——————— Click!

Click! ﬂ]

Click the [[1] (Nozzle Check Pattern) icon.

e To print a nozzle check pattern with the printer
@ operation panel, press down and hold the RESUME

—— e rmmee
By g sy e

[
W B e R
e e e il

button until you hear two beeps then release it.

Read the message and click OK. The nozzle check
pattern starts printing.

T Frod m ri o pasieey

==

T
Click!

Check the nozzle check pattern.

e |f part of pattern 1 is missing, clean the print head. 22— R ——— )
e [f pattern 2 is not smooth, or if pattern 3 is streaked vertically ()
with white, align the print head.

¢ Cleaning the print head (P.70)
¢ Aligning the print head (P.62)
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Cleaning the print head

The print head nozzles could be clogged if there is a pattern missing on the nozzle check
pattern. Try cleaning the print head. If cleaning does not work, consider that ink has run out and
replace the ink tank. If there is still sufficient ink remaining, then execute print head deep
cleaning.

0

NOwWw Nk
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Make sure the printer is switched on.

Click the Start button, point to Settings, and click
Printers.

Right-click the Canon BJC-8200 icon and select
Properties.

Click the Maintenance tab then click the ﬂ (Print
Head Cleaning) icon.

¢ To start print head cleaning with the printer operation
@ panel, press down and hold the RESUME button until

you hear one beep then release it.

Read the message and click the OK button.

Read the message and click the OK button.

¢ The BJ Status Monitor opens automatically and closes when print
head cleaning is completed.

e The POWER/ERROR lamp flashes green for about 30 seconds until
print head cleaning is completed. Wait for the POWER/ERROR
lamp to stop flashing.

e Print head cleaning and deep cleaning consume ink. Avoid cleaning the print head unnecessarily.

P e s |

— @..!_L:_ | Clickt
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Canon BJC-8200

& Start cleaning?

E Bt e s e M e T WA

=

[
Click!

Print a nozzle check pattern to check the results of the print head cleaning.
e |f there is no change after cleaning, use the BJ Status Monitor to check the amount of ink remaining, or

visually check the ink levels of the ink tanks.
If an ink tank is empty, replace it.
If there is sufficient ink, execute print head deep cleaning.

If the printer is not used for a long period, it may not print normally and even up to 5 print head cleanings
may not solve the problem. If this problem occurs, try to clean the print head with print head deep cleaning.

e Printing a nozzle check pattern (P.68)

e Deep cleaning the print head (P.72)
® Replacing anink tank (P.74)




1.

2.

Make sure that the printer is switched ON.

In the software application, from the File menu, select
Page Setup.
® The procedure you use to open the printer driver may

differ slightly, depending on the software application
that you are using.

Click the Utilities button.

A printout is unclear, faded

Bk

Make sure the Print Head Cleaning panel is displayed.

Click the ﬁ (Print head cleaning) icon.
@ ¢ To start print head cleaning with the printer operation

Click!
ey
R — L B

ll-' e ]
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panel, press down and hold the RESUME button until
you hear one beep then release it.
Read the message and click the OK button.
e The POWER/ERROR lamp flashes green for about 30 seconds until
print head cleaning is completed. Wait for the POWER/ERROR
lamp to stop flashing.

& [l T aap——

\
Click!

Print a nozzle check pattern to check the results of the cleaning.
e [f there is no change after cleaning, use the BJ Status Monitor to check the amount of ink remaining, or

visually check the ink levels of the ink tanks.
If an ink tank is empty, replace it.
If there is sufficient ink, execute print head deep cleaning.

If the printer is not used for a long period, it may not print normally and even up to 5 print head cleanings
may not solve the problem. If this problem occurs, try to clean the print head with print head deep cleaning.

e Printing a nozzle check pattern (P.68)
e Deep cleaning the print head (P.72)
¢ Replacing an ink tank (P.74)
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Deep cleaning the print head

When there is sufficient ink in the ink tanks and several print head cleanings have not solved the
problem, execute print head deep cleaning.

D

head cleanings fail to correct faded prints.

N W Nk

Make sure the printer is switched on.

Click the Start button, point to Settings, and click
Printers.

Right-click the Canon BJC-8200 icon and select
Properties.

Click the Maintenance tab and click the 4 (Print head
deep cleaning) icon. T

¢ Print head deep cleaning consumes ink so execute deep print head cleaning only after several print

v

[ -

— Click!

Read the message and click the OK button.

Read the message and click the OK button.

e The BJ Status Monitor opens and remains open until print head
deep cleaning is completed.

¢ Print head deep cleaning begins and the POWER/ERROR lamp
flashes for 1 minute until deep cleaning is completed. Wait for the
POWER/ERROR lamp to stop flashing. When the POWER/ERROR
lamp lights and remains on, you can resume printing.

i— Click!

e e e e ——

— Click!

%L,

Print a nozzle check pattern and check the results of the

print head deep cleaning.

e After executing print head cleaning five times and print head deep
cleaning, if the results of the nozzle check pattern are still not

satisfactory, the BJ Print Head may be damaged or worn out.
Replace the BJ Print Head.

. ¢ Printing a nozzle check pattern (P.68)
e Replacing the BJ Print Head (P.77)

===




1.
2.

Make sure the printer is switched on.

In the software application, from the File menu, select
Page Setup.

e The procedure you use to open the printer driver may
@ differ slightly, depending on the software application

that you are using.

Click the Utilities button.

Make sure the Print Head Cleaning panel is displayed.

Click the @ (Print head deep cleaning) icon. Click!

® You can also execute print head deep cleaning with
@ the printer control panel. Press and hold down the

RESUME button until you hear two beeps and release.

Read the message and click the OK button.

e Print head deep cleaning begins and the POWER/ERROR lamp
flashes for 1 minute until deep cleaning is completed. Wait for the
POWER/ERROR lamp to stop flashing. When the POWER/ERROR
lamp lights and remains on, you can resume printing.

=T TFL] T T

A printout is unclear, faded

Click!
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Click!

Print a nozzle check pattern to check the results of the
print head deep cleaning.

* After executing print head cleaning five times, and print head deep
cleaning, if the results of the nozzle check pattern are still not
satisfactory, the BJ Print Head may be damaged or worn out.
Replace the BJ Print Head.

- e Printing a nozzle check pattern (P.68)
¢ Replacing the BJ Print Head (P.77)
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Replacing an ink tank

When an ink tank runs out of ink, follow this procedure to replace the ink tank.

ON
Make sure the printer is switched on then open the front w
cover.

e The BJ Print Head holder moves to the centre automatically.

Remove the empty ink tank.

_ ¢ |f you need to replace more than one empty ink
tank, remove and replace each tank one by one to
prevent installing an ink tank in the incorrect slot.

e To prevent interfering with the flow of ink from a
tank, never touch the ink port of an ink tank.

¢ Do not remove the BJ Print Head.
@ ¢ Discard empty ink tanks according to the local laws

and regulations regarding disposal of consumables.

Remove the new ink tank from its package. Pull the
orange tape up and against the perforations to open the

packing film. p
e Remove the film carefully so you do not remove /’
the label from the ink tank. If the label is removed,

the ink tank cannot be used.

Grip the bottom of the ink tank as shown in the
illustration and twist off the orange protective cap in the
direction of the arrow.

e To _av0|d spilling ink, never press in on the sides of
an ink tank.

* Discard the protective cap and never attempt to
reattach it to an ink tank according to the
environmental laws of your country.

Hold the new ink tank at a slight angle, align it with the
correct slot, and then insert it. Make sure you insert the
ink in the correct slot.
e Check the color of the ink tank with the label on the
@ printer that shows you the correct slot for each ink tank
to ensure that the ink tank is inserted into the correct
slot.

To lock the ink tank in place, press down on the top of
the ink tank. Press down until you hear the tank lock in
place.

Close the front cover.

e The print head holder returns to the home position and print head
cleaning starts automatically. The POWER/ERROR lamp flashes
during print head cleaning. When print head cleaning is finished
and the POWER/ERROR lamp remains on, you can resume normal
operation.



Color is strange

Color is strange

Inserting an ink tank in the wrong slot of the BJ Print Head will cause
colors to print incorrectly.

Correct color Cyan, Magenta incorrect

Check the position of the ink tanks in the BJ Print Head

Check the positions of the ink tanks in the BJ Print Head.

* Match the color code on the ink tank with the color guide label on the BJ Print Head.
If some ink tanks are out of position, remove them and insert them in the correct slots.

After you have removed the ink tanks inserted in the wrong slots and re-inserted them in
the correct slots, the printer may not print correctly until you have cleaned the print head.

After cleaning the print head, print a nozzle check pattern.

o Confirm that every color is printing correctly.
If the colors are not satisfactory, alternately clean the print head and print nozzle check pattern until the
colors print normally.

. ® Replacing an ink tank (P.74)
e Cleaning the print head (P.70)

¢ Printing a nozzle check pattern (P.68)
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Scanner Cartridge does
not operate correctly

If the Scanner Cartridge does not operate after it is installed, follow the

procedure below to correct the problem.

1

3

Is the Scanner Cartridge installed
correctly?

e Make sure the scanner cartridge is
installed correctly. (P.16)

Is the printer cable connected securely
to the computer and printer?

Check the cable connections at the computer and
printer and make sure that the connections are
tight.

Y

Is the scanner driver installed correctly?

® For details about installing the
software for 1S-52, refer to the Quick
Start Guide.

Scanned images are unsatisfactory?
Other problems such as communication
error occurred?

If the scanned images are wavy, faded, or
unsatisfactory in any way, refer to the
troubleshooting section of the IS-52 Reference
Guide provided on the CD-ROM.

When connected via USB

When the printer is connected to the computer via the USB port, note the following:
Never disconnect the USB cable from the printer or computer while printing or when the

operating system is starting up.

After the printer driver has been installed, if you must remove and re-insert the USB cable from
the printer or computer, always wait as least five seconds after you remove the cable before you
re-insert it. Never remove the USB cable and re-insert it immediately.



Replacing the BJ Print Head

Replacing the BJ Print
Head

After cleaning and deep cleaning the print head, and replacing empty ink
tanks, if the nozzle check patterns are still not crisp and clear, the BJ Print
Head is worn out or damaged and must be replaced. Purchase a new BJ
Print Head BJ-50 and follow the procedure below to replace the BJ Print
Head.

e Discard the old BJ Print Head according to the local laws and regulations regarding disposal of
@ consumables.

Replace the BJ Print Head

Make sure the printer is switched on then open the front
cover.
e The print head holder moves to the centre automatically.

Raise the lock lever to unlock the BJ Print Head.

Grip the pads on both sides of the BJ Print Head and
remove the entire BJ Print Head with the ink tanks in
place.

¢ To avoid staining your hands, clothing, or areas in
the work site, handle the BJ Print Head carefully.
¢ Never touch the metal contacts of the BJ Print

Head.

Remove a new BJ Print Head from its package and
slowly remove the orange protective cap.

¢ Never attempt to reattach the tape or cap to a BJ
Print Head. Discard the cap according to the local

o
laws and regulations regarding disposal of E
consumables. =
. R e
e To avoid poor quality printing, never touch the g
print head. o
>
o
S
|_

——
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Insert the BJ Print Head into the BJ Print Head holder.
Lower the lock lever until you hear it lock.

Install the ink tanks in the new BJ Print Head.

e You can install new ink tanks or remove the ink tanks from the old
BJ Print Head and install them in the new BJ Print Head.

¢ Install ink tanks as soon as you remove them from their package, or
from the old BJ Print Head. If an ink tank dries out, it cannot be
used.

® Replacing an ink tank (P.74)

Close the front cover.

e The print head holder returns to the home position and print head
cleaning starts automatically. The POWER/ERROR lamp flashes for
about 1 minute until print head cleaning is finished.

¢ Always align the print head after replacing the BJ Print Head.

¢ To align the print head correctly, you will need one sheet of High
Resolution Paper.

e Aligning the print head (P.62)




Appendices

e BJC-8200 Printer

Printing method

Bubble Jet ink on demand

Printing resolution

Max. 1200 (horizontal) x 1200 (vertical) dpi

Print speed
(Printing Canon standard pattern)

Black Fast: 3 ppm Standard: 2.5 ppm

Color Fast: 3 ppm Standard: 1.5 ppm

Photo Fast: 0.3 ppm

Printing speed may vary according to content of print job and the processor speed of the computer.

Print direction

Bi-directional

Print width Max. 218 mm
Resident print control mode Canon extended mode
Receive buffer 80 KB

Interface IEEE 1284-compatible parallel interface  Universal Serial Bus (USB)

Interface connectors Amphenol 57-40360 (or equivalent) USB (Series B) receptacle

Recommended Material AWG28 or larger AWG28 or larger

printer cables Type Twisted-pair shielded cable Twisted pair shielded cable (full speed mode compliant)
Length Upto:2.0m Upto:2.0m
Connectors Amphenol 57-30360 (or equivalent) USB (Series B) plug

Acoustic noise level

Approx. 37 dB (When printing with Super Photo Print Mode)

Operating environment Temperature:  5°C~35°C (41°F~95°F)
Humidity: 10% to 90% (no condensation)
Storage environment Temperature:  0°C~35°C (32°F~95°F)
Humidity: 5%~90% (no condensation)
Power supply USA/Canada  AC 120V, 60Hz
Australia AC 240V, 50 Hz
Europe AC 230V + 10%, 50 Hz
Power consumption Standby: approx. 8 watts
Printing:  approx. 45 watts
Dimensions 450 x 333 x 205 mm (W x D x H) with paper support, paper output tray not extended
Weight 5.9kg (2.7 b.)
Feed method Automatic Plain Paper, Photo Paper Pro, High Resolution Paper, Transparencies, High Gloss Photo Film,
Feed (ASF) Glossy Photo Paper, Glossy Photo Cards, T-Shirt Transfer, Banner Paper, Envelopes
Manual Feed Thick Paper
Sheet Feeder capacity Media Max. Capacity
Plain Paper (64 gsm) 100 sheets
Photo Paper Pro PR-101 1 sheet
High Resolution Paper HR-101 80 sheets
Banner Paper BP-101 1 sheet
T-Shirt Transfer TR-101 1 sheet
Glossy Photo Cards FM-101 1 sheet
Glossy Photo Paper GP-301 10 sheets
Envelopes 10 pcs.
Transparencies CF-102 10 sheets
High Gloss Photo Film HG-201 1 sheet
Print media size, weight, thickness Size A4, A5, B5, Legal, Letter, #10 Envelope, DL Envelope
Weight Automatic Feed 64~90 gsm
Manual Feed 64~500 gsm
Thickness 0.6 mm (maximum)
Graphic image printing Data Format Canon extended Mode Raster image format
Resolution Canon Extended Mode 300, 600, 1200 dpi
BJ Print Head BC-50 Nozzles 256 per color
Ink tanks Ink colors Black Ink Tank (BCI-5BK), Cyan Ink Tank (BCI-5C), Magenta Ink Tank (BCI-5M),
Yellow Ink Tank (BCI-5Y), Photo Cyan Ink Tank (BCI-5PC), Photo Magenta Ink
Tank (BCI-5PM)
Capacity Black: approx. 370 sheets (standard 1500 characters per page)

Color: approx. 240 sheets (standard 7.5% coverage for each color)
Based on the printable area of one A4 size page.
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e Printing Area

To ensure the best quality printing, documents should be printed within the border defined by the top, bottom, left, and right
margins described below. Please note that the printable area varies with the paper size. The table below describes the
printing area for A5, A4, and B5.

The illustration shows the recommended printing area and the printable areas.

e For details about the defined printing area for other print media, refer to the instructions enclosed with the
print media package.

I Indicates the recommended printing area to
ensure best quality. ‘ ‘
Indicates printable area where printingis 7777 T
possible but where print quality and precision "{ _______

paper feed cannot always be guaranteed.

Recommended printing area (width x height)

Units: mm
A5 141.2 x 202.0
A4 203.2 x 289.0
B5 175.2 x 249.0 ‘

e Color Image Scanner Cartridge 1S-52 Specifications (option)

Scanning method

Sheetfed Scanner (Band method)

Scanning sensor

CCD

Light source

3-Color LED (RGB)

Scanning resolution

600 x 600 dpi, 300 x 300 dpi, 200 x 200 dpi, 150 x 150 dpi, 75 x 75 dpi

Scanning width (max.)

208.2 mm (8.21in.)

Scanning band width (max.)

10.8 mm (0.43in.)

Scanning time™ 600 dpi 300 dpi 150 dpi 75 dpi
A4 Color 12 min. 50 sec. 4 min. 37 sec. 4 min. 21 sec. 3 min. 18 sec.
Monochrome (B & W) 1 min. 25 sec.. 45 sec. 37 sec. 37 sec.
Monochrome grayscale 4 min. 20 sec. 1 min. 36 sec. 1 min. 18 sec. 1 min. 9 sec.
Original thickness 0.25 mm (.01 in.) max.
Output data B/W: Binary
Color: 24-bit
Grayscale: 8-bit
Dimensions 83 x 82 x 76 mm (w x d x h) approx.
3.3x3.2x2.9in. (wxd x h) approx.
Weight 1509

Scanner device driver

IS Scan (TWAIN-compatible)

Operating Environment

Operating System Windows 98, Windows 95, Windows NT 4.0%, Mac 0S 8.1 (or higher)
Interface Parallel (IEEE 1284 Standard), USB

Display 256 colors or more

Memory 16 MB RAM (32 MB or more recommended)

Disk space 50 MB (more recommended)D

[1. The time measurement does not include the time required data transfer to the computer, paper loading time, or paper eject time.
[2. The USB interface is compliant with Windows 98 only.

[B. At installation the following amount of space should be available on the hard disk:
For Windows, 5 MB should be available for IS Scan and 10 MB available for IS Scan Plus.
For Mac OS, 8 MB should be available for IS Scan and 400 KB available for Copy Utility.



Canon Technical Support

Canon Computer Systems, Inc. offers a full range of technical support
options* including:
e  24-hour, 7-day-a-week, toll-free automated support for troubleshooting issues
on most current products (1-800-423-2366)
e  Speak to a technician free of service charge (currently Monday through Friday,
8:00 a.m.—10:00 p.m. EST and Saturday, 12:00 p.m.—6:00 p.m. EST, excluding holidays)
for products still under warranty** (1-757-413-2848)
e  Speak to a technician (currently $24.99 per call) during holidays and days/hours
not listed above regarding urgent product questions or for products no longer

under warranty (1-800-423-2366)

The same service is available for a charge of $2.50 per minute, to a maximum

or $25.00 per call (1-900-246-1200)
. E-mail support via Canon Computer Systems, Inc. Web site  (www.ccsi.canon.com)
e  24-hour, toll-free Fax Retrieval System (1-800-526-4345)
e 24-hour Bulletin Board Service (1-757-420-2000)

* Support program specifics to change without notice.

hid Refer to individual product information for warranty details.
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e Computer
IBM compatible PC capable of running Windows 95, Windows 98, Windows NT 4.0, with a 36-pin parallel port
connection or USB connection.
Apple iMac or Power Macintosh G3 with USB support.

e Operating System
Microsoft Windows 95, Windows 98, Windows NT 4.0, or Macintosh OS 8.1 or higher.
(The BJC-8200 printer cannot be used with Windows 3.1.)

e Hard Disk
Space required at installation for Windows 95, Windows 98, is approx. 30 MB, for Windows NT 4.0 is approx. 25 MB,
including disk space for temporary files.
Space required for Mac OS 8.1 or later is approx. 30 MB.

e \When connected via USB with Windows 98
The following items are requred to connect the printer via the USB with Windows 98:
e \Windows 98 installed beforehand.
e USB port operation assured by the computer manufacturer.

e To use the BJ Status Monitor, use parallel port LPT1 and a parallel cable capable of bi-directional data
@ transfer.
e The BJ Status Monitor cannot be used if the computer is connected as a network printer. The printer
must be connected as a local printer in order to use the BJ Status Monitor.
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